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WELCOME TO THE WORLD OF
LEGO® MINDSTORMS®

Congratulations on your néw LEGD® MINDSTORHS® NXT robotics tool set. You
now have the power to build and program robots that do what you want!

Uream it, build it

Your HINDSTORMS NXT et enables you to create thousands
of robotic inventions. Intelligent robots that can see, speak, §
feel and move. Lool robots that quard your reom and do your

chares. IF you can deeam if, you can build it!

Build. Program. Go!

. [rfaling a MINDSTORMS robat 1= Basy. Build the robot using

1 your LEGO elements. Program it using the easy-to-use soft-
ware and watch your robot come alive. For your Rrst robotic
adventure, fry ouf the quick-buiid model that you can build

and pragran in less than 30 minutes.

Smart technologies
four HINDSTORHS NXT sat features the latest in robotic technology: an
advanced 32-bit programmable microconfroller: icon-based drag-and-drop

programming software and inferactive challenges: smart sensors and Inber-
active Servo Motors; wireless Bluetooth and USB connection. In Fact, all the

smart technologies you need o create your dream robat.

MINDSTORMS.com
fiou are now a part of the worldwide LEGO HINDSTORMS community. Log on
to HINDSTORHS.com and get more robotic challenges. Download programs,

sound effects and other cool stuff. Share your inventions and exchange tips
and tricks with other MINDSTORHS users.

wiwW HINDSTORHS.com is your néw robotic hot spat.

Find out more
In this User Guide you can learn more about the technology
and the many exciting Features in your HINDSTORHS set.

Hawve fun building your 0wn amazing rabofks!

The LEGD HINOSTORMS team.
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_ | INTRODUCTION

BUILD. PROGRAM. GO!

Build Program bo!

Build & robot. You can hind building Program your roboet fo do what you Bun the program and watch your robot
mstruchions for this mode] |Quick Start want. Use the LEGD® MINOSTORMS® NXT came to life.

madel| in this User Guide, in the saft- Loftware to create a program. Down-

wal®e or ab wiw MINDSTORMS. com. Di load the program to the NXT by using

VOu Can use your imagination fo build the LUSE cahle or the wireless Bluekooth

your own unifue robaot, connechion,

| Quick Start

Use the Quick Start kit to gef your first
MINOSTORMS experience, In the Quick
Start kit yvou will And everything you
nieed to get off to a great start. It will
pnly take you a few minutes fo create
your first MINDSTORMS robaot, test it,

and get a fun reaction.

EmndsTorms

KT HE

| The building instructions for your Rrst
¢ robot starts on page 5 [opposite].

|
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_| NXT TECHNDLOGY

NXT TECHNOLOGY OVERVIEW
The NXT

The NXT i an intelligent. computer-cantralled
LEGO® brick and the brain of the HINDSTORMS® rabat.

" 4 Touch Sensors

Enables the rabot to feel and react to
ITs gIranmant,

Enables the robot to detect colors and light.
Can also be used as a calor lamp.
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k.|

Ultrasonic Sensor

Enables the robot to see, measure
distance to an abject, and react ta
movement.

Interactive Servo Motors

Ensure that the robat maves with precision,

Standard port settings for sensors

and motors

lio make your rohal work comreckly, the sensors anid
mators should be conmected lo specii inpul and oul
put ports, Here are the standard part setiings:

Input parts
Part §1: Touch Sensor
Part ¢: Tauch Yennar

Port 3: Lotar Sensoi
Part 4: Lirasamc Sensor

Cutput ports
Port A: Hotor wsed For an extra fumtHion
Fort B: Hetor for mowompnt

Part [ Hatar For movement

17




_ I NXT TECHNOLOGY

CONNECTING THE NXT TECHNOLOGY

Mok that ALL of the black b=wirp
cabiles can be vsed in both mput
and output ports, sensars and

maters. To work, sensors HUST be
attached ot input ports [1-4|

ardl motors MUST e af tached Fo
e output posts JA=L].

Connecting motors
Toconnect a motor fo the NXT, use ona of the hlack -wire

one af the NXI's outpul ports |A, B, or L].

Lonnecting sensors
To connect a sensor to the NXT, use one of the hlack b-wire

to one of the NXT's input porks |1, £, 3, or 4).

Downloading and uploading

cables, Attach ane end of the cabile fo the motor and the ather fo

cablec, Attach one and of the cable bo the sensor and the other

The USE port and wireless Bluetooth connection let you download and
upload data between your computer and the NXT. IF your computer has
Bluetookh capability, you can download programs to the RXT without using
the USE cable. If your compueter does not hawve Bluetooth capatnlity, you
must use the USH cable or install a Eluetooth LISE dongle on your computber,
NUTE: Read more about wireless Bluetooth communication on page 3k.
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Lonnecting the NXT to a PCwith a USB cable

Turn an the NXT. 9

supervision of an adull,

Makg cure that the

LEGD®™ MINDSTORHS® NxT
Saftware i mstalled Bolore
connecting your HXT to your PL
[soe pagd 4b]

Lonnect the PL and the NXT with the USE cahle,

When the PL identifies the NXT it will automatically hnalize the
ingtallation of the LEGD MINODSTORHS NXT Soffware,

The USE connection must be made by an adult or under

iy Fouend Mew Hardware  © s Founsd Mew Hardeare :
LEGD MIMNDSTOR WS BT J Tl ness P chiag s o el alked and ready ba use,
[, e L

" OL LR

"

Connecting the NXT to a Hacintosh with a USE cable

Hake sure that the LEGD HINDSTORMS NXT Software is installed before connecting your NXT ho

your Macintosh |see page 4/].

Turn on your NXT.
Lannect the LUSE cabile to the NXT.

Lonnect the USE cable to the Hacintosh and you're ready fo go.

19
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ABOUT THE NXT

The NXT is the brain of a2 HIRDSTORHS® robot, 11's an intelligent, LS port

computer-controlled LERD™ brick that lets a MINOSTORHS robot come

Aive and perform different operations,

Corinact & LISE cabla ta the USE pact and dowin-

load pregrams fromyour compufer fo the NET jor
uplaad date fram the robot te your camguter|.

Please note that all text an the NXT display is in English. fou con alsa use te wineless Bluetooth comnec-
" g 4 fion for uploeding and downd pod ing.
k.

Matars pares
The NET has three oufput parts for aftaching s = -
matars, To make He mofor work, the mofors ] L a—
mitidd 1o b afEeghed fo post A, B or I — ]

e 0 E [
Elurfaoth kcan -

L

The B luetooth ioa shaws the ourrent stahus of

sy wireles Bluetoold conmechions, I there 14 ng i

Elwttooth icon shtrmn, Eluetooth i OFF.

#

Blweteoth is ON bet wour NXT is net wisible fo

other Bloefoolh deves.

F<

Eleetooth is O and your KET ks visdale fo other
Blegtooth devices.

2

Elwetooth os UN angd your NET g3 connecled 1o o
Eleetoolth device.

LS g

Wbt i eoaneict ol MXT o b computer with [
& LSH cable, & USE icos will be-displayed, IF you
disconmect the FSE cable, the icen will disappear.

USB

U2 cormeiRed and workang hne.

i
USE cormected but nat working progerty.

nxT

i S S

Semor parts !'

The HXT has four impat ports for abtadhing sen
sars, The sensors need ta be aftached fo port 1,
2. Jord
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i
&

— &= Maming

e
accessible from the Combroller. HAT rames can be -L-j |
ab mosh eight cheracters long —

g O3

e NXT
Tou e change Fhe nama of your NCT by gl:liru] ]
the NET window in the saftware, This wisdow is

B Eattery level

« @

REEOC

Thee Battery icon despbay s hie o er el al 1he
MET. whim hatiery powter 14 low. the Baftery icen
will flashv an and off,

Bumning icon

Wlhin your MCT i4 furned o, Hie rannimg icon will
spine IF the runabng icon skops spinnang, your MOT
has Fracen and you will need ta neset iF [aep page

B3, Trauhleshnotiag. |

Lowdspeaker
Hake a program « ithreal sounds and listen ho
them when you rum the program,

NET butom
Orange bittan: Da'Enter

Light gres hirrones: llsed far maving BeFF and right
i Hie MET ménu.
Dnark ey bhukton: ClearTs hack

Turnimg off your HKT

Technical specifications

« 12-bit ARHT microcontroller

« 256 Khytes FLASH, B4 Khytes RAH

= B-bit AYR micracontroller

= 4 Klrybes FLASH, $12 Byte RAN

= Blugtooth wirglecs communication [Bluetooth Llags 1)
ve.0 compliant

= UISE full spoed port |12 Hbits)

= 4 input parts, b-wire cable digital platform [One pert
includes an IEC 1158 Type 4/EN 50 170 compliant
expansion port for fulure usel

« 1 output ports, b-wire cable digital platform

o 100 x b4 pixel LCO graphical display

= Loudspeaker - 8 kHz cound quality, Sound channel with
8-bit resolution and 2-16 KHz sample rate.

= Power source: b A& hatterips

Mote! A rechargeahie battery pack is available For the
NXT on . shop, LEGD.com.

il ™
Push Fhg dark grey butten repestedly unfil you I‘iﬂ' E: -
s the <t reen on Bhe nght.
Fush Fhe grange butben B Furm off your NET;
persh bl dark griey bl hon bo o back B Fhg mam Tun u;ﬂ:?
ML

mrirs

MXT display options
Towr HAT hias marry oFher codl Features. Fead
more ahout thiem on the Fol i ind s,

ra
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INSTALLING BATTERIES IN YOUR NXT

Battery type
o« The NXT requires b AALRE batteries to funchion properly.

« Alkaling batteries are recommended.
» Rechargeable batteries can be used, bul the NET s power
may he reduced, making the motars turn more slowly.

The normal Function of the product may be disturbed by

Strong Electro Magnetic Interference. IF so. simply reset
the product to resume normal operation by Following

the instruction manual [See page &1, Troubleshaoting). In
case the function could nat resume, please wse the product

in another location.

Low battery power
lWhen battery power 15 low, this icon will pop up on the
NXT's display screen.

Important information about batteries

Never use ditferent fypes of batteries fogether, ora
comhbination of old and new batteries, Always remove

the batteries if the product is not to be used for a long
time or if the batteries have run down. Never use
damaged batteries. Unly use batteries of the type
recommended, or a corresponding fype. Insert the
batteries so thal the pales are correctly positioned.

Rechargeahle batteries must be recharged using the

correct battery charger under the supervision of an
adult. You cannot recharge hatteries while they are still

in the product. and you must never try to do so.

Never attempt to recharge non-rechargeabile batheries.
Never short=circuit the battery halder.
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NXT MAIN MENU
My Files

The Hy Files submenu will let you see all of the programs you
have made on the NXT or downloaded from your computer,

Software Fil es NeT Files SoundFil es
s ' 5|

Software files - programs NXT fles - programs you Saund Rles

vou have downloaded have made on the NXT

From your computer

Files will aubomatically be placed in the appropriate subfalders. When you
download a program including a souwnd Ale to your NXT. the program will be
placed under Software files, while the sound data will be placed under Sound

fles. You can send hles to other NXTs, Read more about this on page 44.

Datalog Files

Datalog Ries = Rles
qenerated when you use

tatalog

£d
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NXT Program

n'_-'

L g

fou don't need a computer o program your robot. Using
the NXT Program submenu, you can make thousands of

difterent programs without your compadter.

Try this simple program and see how easy it is:

Make the robot go hack and Farth when its Tauch Sensor is pressed.
First, the rabot will move forward untal the Touch Sensor 15 pressed,
and then it will move backwards, When its Touch Sensor is pressed
again, the robot will move Forward once again. This will confinue
indehnitely unfil you stop the program.

Make sure that your sensors and motors are connected to the right
ports.

| ——— | 1 p—— | e
|. [ |

b ——e

| <

ATR.
Ly

| <8

select Forward, Use the smow buttans Select Towxh, aelect Backward.

to meee Hhrough Fhe cdoices and then
press the orange button |Enfer fo
mapk g your Selectngn

m
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4

| «

L

W W -

5ol pct Touch again,

Try these programs as well:

1-13 EP‘

(v

How sebect iF you wont the pregram to
Locp. This means that the program will
run again and again undil you swifch
off thie BT, For owr liftle Pest, seleck
Losap.

¥l
&

‘0 HPHIH

|
=

Mefe:

Lising the [olor Sensor together with ~Light loan™ will
givE o positive result when the sensor detects 3 white
color. Using the [olor Sensor together with the “Black
lean™ will §hve & pasitive result when the seasar
detects amy ot her celor than white.

HE

Jd

orH]

I

hhdlg

P

W o 'yl SO TUTY Y GAT GO e,

aimgly sebeck Rual

25
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Try Me

The Try He submmenu lets you test your sensars and motars

i a fum way

]

Connect the sensors and mators to the appropriate ports on

the NXT. Imporfant: Use the standard settings for the ports as
explained on page 17,
Gelect a pragram.

When you press the orange [Enter| button, youwill get some
fun reactions from the sensars and motars.

Explare ather Try He programs to get same more fun sounds, fo
display images and fo experience different motor reackions,

Tiou can always delete these Try He Rles again using the
Gettings submenu.
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View

L o

The View submenu lebs you carry oul & guick test of your
semsors and motors, observing real-time data from each

uimt,

Connect the sensor ar matar you would like to test to
the NXT - the View submenu will help you select the
right port or check standard setfings on page 1/.
Select View on the NXT's display.

| [ B

- i
- e - ¥
T | { T | =
- -
l -‘ - i .‘ . ' -

I J f -
= . A 4 .
| pet Phe ichn Af 1he 4en4or or mator Lelnct Bhe piart that the Sensar o mo- The claka Fram thé sevisdr &F mdker will

vl wiuld like Botadt. You Can andy qnl‘ tair it attached ta. appbar o thes digploy

riead inf g fraam doe Sendor o mafar A
d Fime.




_ I NXT TECHNOLOGY

Settings
e
|

The Settings submenu lets you adjust the NXT's sebtings
including its speaker volume ar the Sleep mode setting.

This submenu will also et you delete programs that have
been stored in the NXT's memaory.

5leep mode: You can set the NXT to turn

itself off after 2, 5, 10, 20 or B0 minutes of
inactivity |Yime when its not in use]. You can also
select the Never setting so that it remains on
definitely unhl you turn it off). Please be aware
that the Never setting will drain your batteries more

J quickly.

el | | Gl
. dHlP - 480 -
L f L. f
Change volume: Oelete all programes:
Here you can adjust the volume You are able to delete all downloaded
of the HXT's speakers, programs in the 4 subfolders: Software

Ales, NXT Rles. Sound Ales and Datalog
Ales, from the Settings submenu.

=]
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Bluetooth

The Bluetoath sulsmeno will let you make a wireless
connection between vour BXT and other Bluetooth devices

|hke other NXTs and compaters|. You can use a wireless

Bluetooth connection to send programs to other NXTs, to
tdownload programs from your own computer

without using a USE cable, or other cool things like using the
Kemote Lantrol in the software to get direct contral of your
robot and send it on missions!

Read more about wireless Bluetooth commumications on

page 36,

29
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%. COLOR SENSOR

The Color Sensor is one of the sensors that gives your
robot vision [the Ulhrasonic Sensor is the ather]. The
Lolor Sensor actually has three different funchions in
ong. The Color Sensor enables your robat to diskin:
guish between colors amd light and dark. It can detect b
different colors, read the light intensity ina room and

measure the light intensity of colored surfaces. The
Lolor Sensor can also be vsed a5 a Lolor Lamp.

suggestions for use
You can use the Color Sensor to sart vour LEGD® bricks, or ta

| make a robat that will fallow & red line or change direction
when b detects a red I1||ul. Tou can also use the sensar as a

calor lamp to give your robat extra personality.,

Using the sensor as a color sensor
To get optimal color detection, the sensor shauld be held at a

right-angle approximately 1 om to the surface. Incorrect color
reaclings can ocour if the sensor is hald at ofher angles to the

surface or if it is used in bright light.
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Using the sensor as a Light Sensor
The sensor can be used to take single light intensity readings.

It functions 3z a light sensor when the light color is set to red.

Using another light color |green or blue] can give different
resulks.

The sensor can be vsed to fake readings of light intensity fram
ambient or reflected light. Amy of the three colors can shine
when reading refleched light.

- Using the sensor as a Lolor Lamp
You can use the sensor as a color lamp ta contbrol the indoviduoal

putput colors (red, green or blue) and add parsonality fo your
robot.

Test it!

Tou can fest the color sensor in different ways:
Lonnect the color sensor to the NXT.

i- =
Select the View sebmenu on fhe T s desplay, Select the colar sensor icon and the Hold bhe coler seasor apgraiimaotely
part where yau hawe connected the sensor, 1 cm above the different colors on fhe

Testpad, and the NXTs display will
show fhevalue and name of the color,

Select the Try Hy submenu on the NXT's display and test your
Lolor Sensor. You'll get a fun reaction.

1
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74 TOUCH SENSOR

The Touch Sensor gives your robol a sense of fouch.
The Touch Sensor detects when it is being pressed by

comething and when it is released again.

S

Pressed Released

Try Me  Testitt

Gl &G Fa

1
.

Bumped

Suggestions for use
You can use the Touch Sensor to do a lot of things: if a robot
has a Touch Sensor connected fo a leg it can tell how Far it hag

moved by counfing how many times the Touch Sensor has been
pressed.

The Touch Semsor can also be used to detect if vour robaot
bumps inko &n obstacle and reacts to it

You can also use a Touch Sensor fo make your robot act on 3
cammand. For example, by pressing or releasing your Touch

GEnsar, you can make your robot walk, talk, close a door or
furn on your TV,

E] Test the Touch Sensor and get & Fun reachion.

Connect a Touch Sensor to port 1 of vour NXT and
select the Try-Touch program in the Try Me submenu

on the HXT's theplay.
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ﬁ?@ ULTRASONIC SENSOR

The Ultrasonic Sensor is the other sensar that gives
vour robot vision. The Ultrasonic Sensor enables the

robot ta see and debect abjects. You can also use if
to make your robal avend obstacles, sense and meas-

ure distance, and detect movement.

The Litrasonic Sensor measures distance in
centimeters and in inches on the NXI, IF is able to
measure distances from 0 to 255 centimeters with a
precision of /=3 <m,

The Ultrasonic Sensor uses the same scienfihc principle as bats: if measures
distance by caleulating the hime it Yakes for a sound wave to hit an object and return

= just like an echo.

Large-sized ohjects with hard surfaces return the best readings. Objects made of
soft Fabric or that are curved |like a ball] or are very thin o small can be difficult for

the semsar ta detect, Euggﬁﬁnng far uce
You can use the Lltraconic Sensor in
. mamny differenf ways. Program a robaot
wilth each other s readings. to speak around the house wilhout
it bumging into things. Or make an
ddvanced burglar alarm rabat that

. reacts to movement as well as light or
Test it! color settings.

Test the Ultrasomc Sensor’s ability to measure distance;
Lonnact the Ultrasonic Sensor fo the NXT.
Select the View submenu in the HXT display.

Note that hwo or more LHirasonic Sensars operating in the same room may interfere

3 : \ e

1 y |t ﬁ‘.ﬁ Y I
Lo =
Salect the lHErasanic Senior stan Hanture the dhttande to an abject. Far sxanple, sdwe your hand doter ta
il thé port whiere yéeve ton- the eaasor and wahéh the réadengi Chimge,

rapibecd Fhe gdmigar

Select the Try He submenu on the NXT's display and test your
litrazonic Sensor, You'll get a fun reaction,

33
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INTERACTIVE SERVO MOTORS

The three Servo Hotars give your robot the ability

to move. If you use the Hove block in the
coffware to program your motors, the two motors

will automatically synchronize. so that your robot
will move in a straight line.

Built-in Rotation Sensor
Each mobor has a built-in Rotation Sensor. This lels

vou contral your robot’s movements precisely. The
Ratation Sensor measures motor rotations in degrees
or full rotations |accuracy of +/- one degree|.

Une rofation is equal o 360 degrees. so if you sef a
motar to turn 180 degrees, its output shaft will make
half a turn,

Test it!

Test the built-in Rofation Sensor's ability fo measwre disfance:

Lonnect a motor to the NXT,
Select the View submenu in the NXT's display.

4ub
w

The bwilt-in Rotation Sensor in each
motor also lets you set different speeds

Far your mobors |by setting different
power paramelers in the sofbware]. Try

running the mators at different speeds.

Ll bl

=3

wplec] The Motor Hod af o ston Mow atHtath o whisd 1o thi meodor end mestove e rotahiong as you roll Fee wheel aleng Fhee Hgor,

select the poot wheré yiu bayve
condcted the sdtor.

Select the Try Me submenu an the NXT's display and Fest vour

motars. You'll get a fun reaction.
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==zl 1, The motar
— 2l ¢, Tachomater |Ratation Sensor|
1. Built-1n gearing

15
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Bluetooth is a technology that makes it
possilile to send and receve data withoud
using wires or cables. Using Bluetooth.
you can exchange programs beb~een your
computer and your NXT ar even belween
vour HXT and other NXTs. You can also

establich a wireless connection between
your computer and your robot fo control it
remately!

IF oo computer does nat have NXT com-
patible built-in Bluetooth capability, you
must use a Bluetooth USE dongle. Hake
sure that you use the right type of Blue-
toath USE dongle. Read more about the
different types of Bluetooth LUSE dongles
1o use at wiww MINDSTORMS. comybluetooth



_| NXT TECHNOLDGY

CONNECTING YOUR NXT TO A COMPUTER

Before vou try to sef up a wireless Bluetooth connection, make sure

that your computer has Bluetooth capability.

The LEGOD NXT has a Class £ Bluetooth radia. This will have a range

of approximately 10 meters when used with a compahible Bluetooth

device [class | or 2.

'I--h

MAKING THE CONNECTION TO A PC

4

Make sure that your NET i turned on. Alto
gk Sure that vou have Bluetooth set to
O @ne that your NXT is set to be Visible
[read by in the Bluetoott submenu on
Phe NET on page 42). Alse make sure That
Bluttaath & installed and énabled on yaur
compuber. See your computer’s and
Blueteoth device's inchruchion manuals

Far detals.

aad oL

Find the Lontraller at the lower right comer
of the work area in the software, Click gn the
N T window button [Mhe one af the upper left|
and the NXT window will open,

37
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=]

3

| et Pyt o e e

3 Pt

= [ e=t |

‘P

Click Scan. Your computer will automatically search for
Bluetoath devices

After a short inferval, a list of available Bluetooth devices
will appear in the window on the computer screen. Select
the device vou want to connect to and click the [onnect
[t o,

whon you connpct to a device for the st tme, the Entor

Passkey window wWill pop up. Enter the passkey 1o use with
thit device [the dofault pastkoy is 1234) and click DK
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Enter the passkey on your RET and confrm the connection
vy pushing the orange |[Enter] butten. IF you have chosen
the defaull passkey, just click the arange [Enter] button,

\ | In the NXT window, the status of your NXT has now changed

from Available to Connected. Your NXT and computer are
N Connpcted and can share daka.

Make sure that your NXT is turned on. Also
make sire that you hisee Ehietoath set ta
On and that your MXT is s¢f to be Visible
{read o incthe Bluetonth subhmpenu on
thie NXT on page 42). Also make sure that
Blustoath is installed and snahled on your
computer. See your computer's and
Biluetpath device’'s inchruchion manuals
Far details.

b
o

Find the Confralior at tho lnwer right corner

af the work area in the software, [hidk on the
HET window button [the one at the upper left|
and the NXT window will open.
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Click Scan. The Bluetooth device window wWill pop up on Hie
A

A Bist of Bluetooth devices will appoar in the Select
Brietnath Device windms an the ceresn, Splpck thio device

wou want to connect to and click the Select hutton,

Thp NXT that vou want to cannect to appears in the NXT
window as avaitabile, Click the Connect button,
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3 e \ The Pair with a Blugteath Device window pops up.
e . Select the BT, Click Pair.
i -
LU W TP L A
f 9 daimra boammy Dyrrd 220 o e thg B mopne
WPl B B S o R | PRSI R o, R0 R ey
| B . F DS BT 1 TR FELA PR ST T O SOOI
| AL gL
| 1 Caps maly AR Do =3 |
o Cowwne Sabrqerr  AS Categer m s |‘
[ fa— H
| emitm AGRIE Lansal [.-. _] ?
E=E='-

- S Bl When you connect 1o a device For the Arst time, o Passkey
-!;ﬂ-rln—_ ‘ windaw will pop up. Enter the passkey to wep with this
h —_ 4 device [the default passkey is 1234 and chick DK

E Fhabt BB 3 Fo b OO LSk man i D
4

Pk bl i B Wl B Pl T BB Dk TR ERTE

Fid LMy A OO 4SRN R B sl JLAN L Emp . S
il d rars o e e imaie pisa sme Piaaies b e me
——l:l I L PR TS o

kT
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Enter the passkey on your NXT and confiem the

comnection by pushing the orange [Enter| buttan, If L

yiou have chosen the default passhey, just click the

orange [Enter] buttan. In the NXT windose, the skatus of your NXT has now changed
Fram Available to Donnected. Your NXT and computer are
niid conneched and can share dafa,
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BLUETOOTH SUBMENU ON NXT

Iiibi

Blugtanth

Lelect the Bluetoath submenu on the

NAT ispday.

I

| -c;'mi{

Py Contachs

Tou com see oll of your trusted Bluetooth contacts

in Hy Contacts. These contacts con automaticadly
connect and send dota to your HXT wédout usng o
possiey, To add o new cenoct o Fhe bist, vou must
horve been connached to the confact belore. Devices
wihich yau have bees conneched ta. will subomarticadly

be added Po the ligh i My Contagis,

m

bbb

| <

b —&

P

1
-

J_-|
i

:

-

| 1='r

Cearch

Gewrch for obher §luetooth devices. After you have chesen the Seandh
iczs, your NKT will autamatically start fo search far other Blustoath

devices thak it con connech Fe.

|

| ems }
[

b

/!

-

Conmec o

This item displays yaur currend connections. You can

cormech wour HxT ta fhree devices at the same bime

|om Lise 1, £ and 3], whéle one device con consech o
yau [on Line 0), Hete, bowever. that while you con
be “connected Fa up fo three devites. you cas only
“commainicate” with ane device at a bime,
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J = T o N -~
=4
I
|
Commss [ e | Cd= ) [

You can also view the connection stetus in Fhe HXT windaw in fhe
Software. There you can change theneme of yeur HET, connect to
ofhlr Bl doanth disaded and chedk bt bery and memory liseils,

Check the cennection states in the icon bar ot the fop of
the NXT s dizploy,
Wt 15 rvd Blusetoeth ican shiwn, Bluetookl s OFF.

* Eluetontt i ON but your HXT 15 notvisilde
fo oHser Bl lach b devifes.

:# { Eluetoath is ON and youor NXT |5 visible ta
other Blustoath devices.

*'ﬂ} Eluetoott v ON and your NET 15 conected
fon Elustooth device,

|
3

| on

{

|
Wisibility Passkey
e the Visible aptian te make your NXT The Passkey enaures thet aaly Blietoath
wrsible ar inviesihle Fo obher Bluetoath divices appnteed by you can Connect 1o
drwice s when they da s Blistaoth search, your NET, Whentver you comect foa

B luetanth device Tor the Rrsk fime using
your NET, you will be asked For a passkey.
Selact the preset passkey 1234 or make up
yOUr oeen e, Dter ©luetodth oeyvices
ruiSF o o passkey in order fo confirm
& CONPRCH AN Wik yaur NXT,

{
E

|«

O/ OIF

Yau can turn Bluetooth furchianality oa
ar 6fF. 1F you furn Blustacth off, yau will
nak he abibe 10 send oF recer e daba oy
Bletenth. To save battery power. hum
olf Fhe Eluefooth function when 1F 15 Aot
IUSE.

ue
=

Hote! Hluetaokh s turned alf by default.
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CONNECTING YOUR NXT TO ANOTHER NXT

| |
|

2 —

I._ - L I"'_ '
gy | . Y e
| E dEb -
/ / - ¢
Select the Bluptooth submenu Select the Search icon fo search for Uepending on haw many devices an
on the MET's display. other Bluetoath devices. Your NXT will detected in the area, a list will pop up an
airtomatically search For Bluetooth the NXT's display after a Few soconds,
devices,
G p—
- fe. - i
- r : &
-‘ : 3
f [ ]
Lelect the device vou want fo connect o, Seleck which of the three lines of cammunication you wank the connectian to
Remember fhat you can give each NXT a be on [1. 2 or 3. You con connect yvour KET to three diffesent devices af the
AR PAn D same fime.

- 50 Maming the NXT on page 21.

m

If vau cannect to a device Far the Rirst time, vour NXT will ask For
J passkey, Jus! press enter to use the default passkey 1234 o
make up your own code. The other Bluehooth device must know
vour passkey in order to canfirm the conection. This means
that the two M T nead to to enter the same passkey in order o
canmec!,

IF you want to connect vour NXT to mare than one Bluetooth
device, go to fhe My Lonfacts submenu to select a frusted confact
or slarl a new search.
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Lonnecting to more than one NXT
You can connect up to three KXTs or other Bluetooth

devices fo your MXT at the same time. However, you can
only communicabe with one device at a time.

Sending Fles From NXT to NXT
It's easy to send programs Framyaur NXT to another NXT:

0 p——

| [
I ]_;
i &

~

Make sure that your NXT &5 connected to Select Send.

the NXT to which you want ta send the Splert which af the cannected devicet you
program [see page 44, Loanecting your want the program ta be sent fa [Line |, 2
NXT to anather NXT], ari|.

Golect the My Files submenu in the HXTs

disphay and sebect He program you want Your NXT will non send the file.

o send,

31111111133131: 11:13111333q1§3;3§§ 15111

TFITAFAFAFTA AT TAFIFIF TR NI TFATIN

i
o HEIEERA S X 1 !;i

333 11* :Ir 333 }Eq 4 1:
bk

45




2 SOFTWARE

SYSTEM REQUIREMENTS

Before installing the LEGD™ HINOSTURMS® NXT Software,
you must make sure that your computer meefs the
Follow ing minimum system requirements:

- Microsoft Windows - Apple Hacintosh
» Windows XF Professional or Home Edition wilth Service « Apple HacdDS X v10.4 or v10L5
Pack & or nower, | » Posmer?L® b, b4, bS processor, B HHz minimum
s Intel® Pentum® processor or compatibile, 800 MMz » Intel processe
BT ML » |1.1 bHz or hetter recosnmended|
o [1.5 GMz or belter recommended] o (Vl-drive
= Windows Vista Service Pack 1 or newer, » 51¢HE of RAH minsmum
» Intel® Pentum® processor or compatible, 1 BH2 mini » TOOME of availabile hard-disk space
i o Xhi display |10 '&H)
o | 1.5 Gz or better recommended| » 1 available USE port
= LI-RIH drive » [ompatible Bluetookh adapter [ophional] ®
« GIZME of RAN minimum
= (HE of availabie hard-dick space
o XGA display [ 1024x7TEE|
= | available L5%E port .-"Il ."’I
» [ompatible Bluetoath adapter [optional]”

= = J

" | Suppirtiad Blestanth sofhware mra s idcomm® Blusdoath For o millied & newds Hhin oo 1 4.2 10 5P5 and the Bhetonth stacks inchuded in Miorosalt Wisdos s XP
with Servace Pack & or adwar, Windaws Victa or Veita Wnhest Service Pack, Apple HacO5 X 104 andd 1005, e weww MINOSTORHS € om's hmiooth.

INSTALLING THE SOFTWARE

Hicrosoft Windows

1. Exit all open programs.

£. Insert the LO-ROM

|If the LO=-ROY does not ren automatically: Double=click the
autorun.exe file on the CO-ROH)

1. Follow the on-screen instruchions

| 46
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@ | Ean MONDRTORMG ST Vo ‘ Select your preferred language.

Follow the an-screen instructions.

SmindsTarms

i

0 1 Apple Macintosh
Il'n Exit all open programs.
'- Insert the LO-ROM.

Open the “LEGD MINDSTORMS NXT™ CO-ROH and double-click Install,

Select your preferred Language.
Follow the on-screen instructions.

When the installation procedure 1s complete, click Fimish, You are now ready ta use the
LEGD HINDSTORMS NXT Software and create programs for cool robotic imentions.

4T
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YOUR FIRST PROGRAM sovid e A8 kil you et b o

connech yvour compuber to the NXT,

Ytart the software on your PL or Hacintosh
by double-clicking the program icon.

Type in the name of your hrst program,
or jusk click on Go!

L

Create new program  [C BOEEE oo

ol % Open recent program | e I e

" First, click on the Sound block icon in
‘ the programming palette.

. @!r I
=
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P T ' Orag a Sound block and drop it to the right of the
_ Starting point in the work area.
‘ ' Tour program s now réady to download and run,
-'-_rl

Hake gure you turn on your NXT and conneck the LU5H
cable to both your compufer and the NXT |see page
|8, Connecting the NXT technalogy).

Lacate the LCanbraller in the lower ||-;Jl:+r cormer of Hhe
waork area, Llick Download and ren [the central but-
ton| and listen to what happens,

Longratulatians, you have completed your Arst
program!

49
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SOFTWARE USER INTERFACE

A quick overview

==
. Roho Center e
¢. Hy Portal -
3. Tool bar h
4. Work area -
5. Little help window 1]
B. Work area map T
I, Programming palette
B. Confguration panel

9, Dontraller
10, BT windin

G0 m B oS BT
e G Tk fee [
:rlﬂ:mﬂl DEE

Oa: Qs 0OF ﬂ B et | B | sid helpr ]
e 5 O OBl | Bowien [ )0 T | Sieuns ":.'..:::.-:E-m---m.._, 3

[ SRR 1 (8 Ta] e b ke O G
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(]

E =

=

[
]

1]

Robo Center window
Here you can find building and programming instruchions for four cool models.

My Portal
Access www HINDSTORNS.com to get new models, programs, sounds, images, tips and tricks and be
part of the great LEGO" MINDSTORNS® communiby.

The tool bar
The tool bar provides additional tools enabling you fo calibrate sensors. create cushom sounds and im-

ages for the NXT or create NXT files to share with other HINDSTORMS users.

The work area

This 15 the space on the screen where programming fakes place. Drag programming blocks from the
programming palette to the work area and attach the blocks to the sequence heam.

Little help window
Provides tips and help for the specifc function you are using at the moment,

The work area map
Lise the work area map to get an overview of your program. Click on the work area map and drag it over
the part of your program you want to see.

The programming palatte

The programming palette contains all of the programming blocks you will need to create your
programs, The fabs at the bottom of the palette let you switch bebween the common palette |containing
the most frequently used blocks), the complete palette [containing all of the blocks|, and the custom
palette [containing biocks that you download or create yourself].

The configuration panel
Each prngramm'rm] block has a :unﬁguraﬁun pangl that lets you customize the block for the specific
mput and output that you want.

The Controller
The Lontroller allows you to communicate with your NXT. Transfer programs and hles, start and stop
programs or change the settings of your KXT.

The HXT wind ow
This pop-up windimw will give you information about your NXT's memory and communications settings.
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THE ROBO CENTER

‘Hobo Center

Yo e,

& ekt b il

Ca vl buld the Shooksrliot bo probact wour rooin? Tiou will havs bo &34
ke | Rr aorm. Sesretr Lo oo Shodl e Bol.

In the Bobo Center you will hind different robal models
that you can build and program to do what you want.

Liart Iy selecting a rohot medel to Build and pragram.
W e recommend that yvouo start with the ShooterBot a5 it 15 3
rantinuation of the Queck Start madel included in the box

Fallow the an-screen bullding and programming
insfruchsons = or solve the Chal lgnge an your 0w,
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v 1 Tost your robot wsing the challonges provided,
-!-I:'E!F-l.-l-lllll'l-hll| o v b=

E'.I 4 barn o Bf OQram

Coah o) procp s e Sheober Bt bo wan o room and delbect
abects T IF an obrenct 5 ceder than 40 ¢y, Bhe Shooterot sheakd 2hind
& wasrriing Bght s thery shoot Fibe oblect does rok mowe sway,

The programming palette contains all of the programming
biocks you will need to create your programs. Each
programming block defermines how your robiol acls or
reacts. By combining bocks in sequendce, you can create
programs that will make your robol coms fo life,

when you have hnished creating your program,
download it to the NXT and run if.

Remember to burm on amd commect your NXT before
downloading a program,
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The three programming palettes

Ta simplify its use, the programming palette has been
divided into three palette groupings: the common
palefte [confaining the most used blocks). the
complete palette |containing all of the programeing
blocks|, and the custam palette [containing blocks you
download or create yourself|.

Tou only need to wse the blocks below to complete the chal-
lenges. The color sensor blocks can be found in the complete
palette, while the others are locaked in the comman palethe.

The saftware’s help area has more information about thee rest

of the programming blocks when you are ready bo move on,

Howve block

This block controds the robots motors and
synchronizes its movempnts. Ue this hiock to
set your robot ho go forwards or backwands in
a straight line or to turn by following a curve.

Record/'Play block

This bbock fets vou recard a physical
maverment with your rabat and then play badk
the recorded movemont elseshore in the
pragram.

[alor Lamp block

Lse this block to furm on M red. green or
b light in the Coler Sensor, Yoo cam, for

example. make your robot shine the red light
a5 3 Waming signal.

Lolor Sensor block

This block enahles the Color Sensor to identify
colors. This makes it possible to lave yous
robot react differently depending on the
colors it defechs.

_—_

T ——————————————————————

—

8
O

Display block
Use this block fo display an image, write some
test, or drand 8 Shape on the N s display

SLrgen.

Wart block

Thic black lets your robaf cénce its environment
for @ specific condition before it continues with the
program, For example, use the Wait blodk to make
the rabal wait for a specific color. touch or time,
before it moves on with the program.

Loap hlock

Use thas block il you want your rebat fo do the
camp thing agam and again, For ecample, make
your rebol move forwards and backwards
cantiminusby until the Tauch Sensor i prossed.

Switch block

This hlock lets your rahot make its own decisions,
such as going lelft when it lears a foud noise and
going right when it hears a softer noise.
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THE CONFIGURATION PANEL

Each programming block has a confiquration panel that leks you adjust the
settings of the block For the specific actions that youwant. When a block
is selected in the work area, its configuration pangl will be visible at the

bottom of the Screen.

iy changing the parameters on each configuration panel, you can change
how a particular block will behave. For example, ta make your robot move
faster, you can change the Power property on the Move block's configuration

panel.

= L SRl

THE CONTROLLER

The five buttons an the Contrallér communicate from your computer to the HXT:

The NXT window button gives you access
to the NXT's memory and communications
settings.

|
=

The Download button dewnloads the program
ta the NXT. You can then run the program

Fram the NXT.

The Download and run selected huttan
downloads and rums just a piece of your
program's code |e.q. a smgle block or just

a few blocks). Select the blocks you want

to test and click on the Download and run
gelected button, Youwill then be able to see

] how the small sequence of your program

performs on the NXT without having to
downioad the whole program.

The Download and run buttan
downloads a program fo the

NXT and then starts running the
program.

=l The Stop button stops a running program,
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SOUND EDITOR

The Sound Editor allows you fo add your own sounds to the NXT.

Yiou can add sound Ales already stored on your computer® . royalhy=free fles found on websites, and even
record your own voice and download it to the NXT.

EoR F00 Hele

A rse Seannes

Liamiaiis KT Firemssii

CTEITE FACE ang (0.

Flock Imgio® Jnd Fxpon Wiz
Image E30dr..

i ol Comiral

You can Angd the Sound Editor in the HXT
software under Tools® m the menu bar.
Click on it to open it.

o have the option to gither import an
existing sound fle or record your own
cound fila.

lo import a sound, click on “Import” and
choose a Alé Ffrom the Iocakion [on your
computer| where you have stored your
sound fles,

To record your own sownd vou Rrst
need to have a microphane cannected

to your computer,

Llick on the "Record’ butten and create
a Sound into vour midrophone. You
can record up to 10 seconds of sounds

and edit the length of the recording
alterwards.

J

You can also trim |cut| the size of your
saund fle by moving the small trian-
gles until the length is as you want it,

Lave your personal sound Rles in the
NXT software's library. You can give it 2
fitle that is easy for you fo remember.

For examplé "My Arst sound,

The Sound Editor displays the maximum size [fle size limit] that you can download and store in your NXT's memory,

The sound Rle will appear in the lisk of sounds in the Sound Block.

Now you are ready to make your NXT robot say or play whatever sound you want it to!

*You can 3o dovnload sqund files from ather wsurces, like 8w Iefemned. Do ngle that some el may equine s liconse o regally fo by wed

=]
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IMAGE EDITOR

Lsing the Image Editor you can create your own images or stored images and download them to the NXT, so

they appear in the display on the NXT!

E ol i bemie B e pmery
LD MGAT Fliimwiale
LTEle Fack ang 0o,
ROt Friadr and Eeport WWiEand

Rarmale Conirl.
SouUrd EFEIr.

ir

)| 8 - |

fou can And the Image Ecitor in the NXT
sofbware under Taols’ i the menu bar.

J.-"
To import your own image fo the Image

Editor click “Import’ and choose an im-

e from where you skore your imanges.
[The default is the Iibrary of images

that comes with the software. |

Tou will be able to crop the image and
ta set the level of detail to be dis-
played on the HXT.

Now you can access your picture and add it ta a program and download it to your NXT.

Try it ouft

In the Image Editor you can chanie
vour image to Al the size of the NXT
display. which is 100 pixels by b4
pixels. You can alsa change the level
of detail From your original image by
mowving Hhe slider,

You can also create your own image and
add fext to it using the drawing tools.
Once you have adjusted an imported
imagje or have created your own image,
you can save it ho the image library in
the NXT Software.

£1)
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REMOTE CONTROL

The Remote [ontrol gives you direct control over your robot!

E L abirEs e
Lipdgie T Firmmersre .
e P STk el B

DS E FRann anm CEndn Visam

mapge BT,

f

You can Angd the Remote Lantrol in Hhe
HXT soffware under "Tools' i the menu
bar. Click on it to open it

o

To take cantrol of your robot you need
to have a connechion between your PL
and your robot. If an active connection
already exists, the window will desplay
the name of the connected NXT. You can

change the active NXT without closing
the Bemote control.

J

Prss the arrow keys on your kéyhoard
or on screen wWith yvour mouse ta drive
your robot in the direction of the
arrow, The spacebar will actvate an
action motor on your robot to allow you
to move and react at the same time,

If there is no active connection, the screen will say “No NXT Connected” and you will have to choose the

NXT you want to confral.

You now have direct centrol and can fake your robot For a spin!

]
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TEST PAD

Test all vour models on this Test Pad.

e

EmindsTorme | TEST PAD O 8547 § |

szl This is the starting point on the pad.

m—
| 59 |
1 |
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TROUBLESHOOTING

Resetting the NXT

If the running icon stops spinning, your NXT has frozen
and you will need to reset if. Follow these steps to resel your NXT:

I, Make sure that vour RXT is turned on.

£. Push the reset hutton that is located on the hack of
your HXT in the LEGO® Technic hole in the upper left
corner. Use, for example, an unfolded paperclip to press
thee buttan.

Note! IFyou press the reset button For more than & sec-

onds you will need bo update the Rrnmware [see below].

Updating the Armware in the NXT from your computer
Go o Teols = Update NXT Firmiware.

B LEGO M

O B

Corenn

. l"‘:;,.

Fle Edt REZLY Help

‘ 1. Hake sure that your NXT is furned on and has fresh

_ Hote! IF you have just reset your NXT |see above| the
£ albrnte Sersors E display will be blank. A ticking scund will tell whether
L ta 8T Frbasses it 15 burmed on or nof.

Create Pack and Go... . Make sure that vour NXT and computer are con-
Bk Igrort aned Expirt Wizeed. . rec ted with the LS8 cable,

E::I'EE;"'E“ L 3. bo to the Tools pull-down menu in the soffware’s
i E".FE.-EI:'I r':' ; menu bar and select Lipdate NXT Firmware.

4. Chose the hrmware that came with the NXT soft-

wWarg or browse 1o niwer Rrmware downloaded From
the LEGD website.

5. Llick Dowinload
B. When all three progress bars are green the

Armvware update is complete
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Select the Arnyare you want ta update.

Click download. [Note! The Windows “Found new
hardware wizard' will pop up the Arst time you
update your firmware. Lomplete the wizard lny

F::llluwirlg the on=screen instruchion before yiou
confinuel.

For other bypes of troubleshooting, go o www HINDSTORHS.com/suppart

FCC appraoval:

The LEGD Group herehy doclares that the LEGDE MINDSTORMSE MxT |A547|

complies with the requirements of the refevant provigions of EU Directive 1999/%E.
Under canditions in which static electricity might accur, the unit might switch itsedf to
standby mado. The unit may have to be recet by the uer.

pai e itk ek
,,;ggn“g:gn,:r §=~§3= 3RS EHTE:
g, i?iﬁ iiiiﬁq_ﬂﬂ ,Eiigéﬁ 3331 3;33.33:,

bt
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3

LY

LT

Protect the ermrdrcnemant by not disposing of this product with your housshokd
wasle (ZO0ZBEEC). Chack with vour ocal authonty for ecycling achvics and
faciikioa

Schitren Se die Unwell und enteorgen Sle diesas Prociulet nichit mit heem
Hauemndll 2002B8EC). Informaiionen Du Recyciing - Wi tboeRen shafen
B ol dan Srtllchen Bahindan

Protéges Famdrcnnamant | ne jataz pas ca prodult aved vos autres déchats
miénagers (Directive auropsdanie Contactes lea automisa
Iocabkeg powr obrtanir dea Informnalions aur s recyclkags of connaline |es
points de colleche,

Protegg! fambilenial Non emalire questo prodotto con | ifutl domestic
(PU02REEC) Per consulenza sul Aciclaggio dal dfut B e strutture di
riciciagpic, rivodperal alla proprie autooka locall

Buscharm het millew: gool dit product nlet samen met et andere hulell

Proteje ol medic amblante no desheclindoess de este productio junie con
sun reaiduce domieticos (200RSMVEC). Gollche a su eutorkdad local
comnseion @ Informacién scbre Inslelsciones de recicledo,

Basloyt milest] Smid ke dete produit ud semmen med ehoidningesfTaldet
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RO02RLEC) Virsletea vieth e vares leatlcds, lul noakaddroty, kur un kil
tag nododama plretridel
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dmbertiilemispunicide koltta ssete ssjlscmaselt kohallkult peutumedt.
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